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Tässä työssä kirjoitettiin yksityiskohtainen ja tarkka työohje kaksikerrospiirilevyn 
valmistukseen jyrsimällä. Käyttöohjeen tarkoitus on olla apuna piirilevyn valmis-
tuksen opettelussa sekä tukena työntekijälle, jotta hänen ei tarvitse muistaa 
kaikkia yksityiskohtia ulkoa. Näin minimoidaan virheiden lukumäärä ja selkeyte-
tään työn tekoa.  
 
Työssä tehtiin video ja posteri, joista käy ilmi, miten piirilevyjä valmistetaan Ou-
lun seudun ammattikorkeakoulussa. Videota ja posteria voidaan esitellä mah-
dollisille asiakkaille.  
 
Työohjeesta tuli selkeälukuinen kappalejaon sekä hyvän sisällyksen ansiosta. 
Kuvat eri työvaiheista auttavat myös ymmärtämään paremmin työohjeessa ku-
vailtuja kohtia. Myös yksityiskohtainen työvaiheiden selittäminen auttaa työn 
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hin on lisätty kuvia parantamaan visuaalista ilmettä ja selkeyttämään työvaihei-
den ymmärtämistä. Videossa työvaiheet on esitetty selkeästi ja yksinkertaisesti. 
Näin asiakas saa yleiskuvan siitä, miten piirilevyjä valmistetaan Oulun seudun 
ammattikorkeakoulussa. 
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The aim of this thesis was to write a detailed and precise manual for manufac-
turing multilayer circuit boards. The purpose of this manual is to help to learn 
how to manufacture circuit boards and to help workers so that they do not have 
to remember all single details by themselves. 
 
The second aim was to make a video and a poster which show how circuit 
boards are manufactured at Oulu University of Applied Sciences. This poster 
and video can be shown to the customers. 
 
The manual is easy to read because of the chapters and a good table of con-
tents. The pictures also help to understand what workers have to do in each 
stage. In addition, two different posters were done, one in Finnish and the other 
one in English. There are also pictures of different stages in the posters to im-
prove their appearance and to help the reader to understand those stages. In 
the video, the work stages are represented simply and clearly so that the cus-
tomer gets an impression of how double layer circuit boards are manufactured 
at Oulu University of Applied Sciences. 
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1 JOHDANTO 

Työn tilaajana toimi Oulun seudun ammattikorkeakoulun Protopaja. Opinnäyte-

työn aiheena on työohjeen laatiminen kaksikerrospiirilevyn valmistamiseen käyt-

täen jyrsintätekniikkaa. Työohjetta voidaan käyttää apuna piirilevyn valmistusta 

harjoiteltaessa. Lisäksi vaadittiin esittelyvideo sekä posteri piirilevyn valmistuk-

sesta Oulun seudun ammattikorkeakoulussa. Esittelyvideon ja posterin avulla 

voidaan visuaalisesti esittää asiakkaalle, miten piirilevyn valmistus tapahtuu.  

Työohjeessa opastetaan kattavasti koko piirilevyn valmistus työvaiheittain. Työ-

ohje tehtiin hyvin yksityiskohtaisesti apuna käyttäen kuvankaappauksia tietoko-

neohjelmista havainnollistamaan paremmin kyseisiä työvaiheita.  Posterissa on 

myös mukana kuvankaappauksia sekä valokuvia eri työvaiheista. Videolla käy-

dään työvaiheet läpi pääpiirteittäin, jotta asiakkaalle jäisi selkeä kuva piirilevyn 

valmistuksesta. 
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2 TOIMIVAN TYÖOHJEEN LAATIMINEN 

Työohje on tärkeä ja oleellinen osa työn toteuttamista. Sen avulla työntekijä 

pystyy tekemään ammattimaisesti ja tarkasti kaikki tarvittavat työvaiheet unoh-

tamatta mitään. Työohje auttaa myös noudattamaan työturvallisuutta ja täten 

vähentää työtapaturmia ja laiterikkoja. 

2.1 Ennen työohjeen kirjoittamista 

Ennen työohjeen kirjoittamista on hyvä käydä tehtävä työ useampaan kertaan 

läpi ammattilaisen avustamana. Työtä seuratessa on hyvä tehdä paljon yksi-

tyiskohtaisia muistiinpanoja eri työvaiheista. Jo muistiinpanoja tehdessä on hy-

vä otsikoida työvaiheet niin, että myöhemmin on helpompi jakaa työ eri osiin. 

On myös suositeltavaa ottaa kuvankaappauksia ja valokuvia työvaiheista. Näin 

taataan se, että työohjeesta tulee tarkka eikä mikään työvaihe pääse unohtu-

maan. On tärkeää myös käydä läpi laitteiden käyttöohjeet ennen työohjeen kir-

joittamista, jotta työohjeessa voi mainita tarvittaessa esimerkiksi työkoneisiin 

liittyviä turvallisuusohjeita. (1, s. 42–49.) 

Tätä työohjetta tehdessä seurattiin ammattilaisen piirilevyn valmistamista. En-

nen työohjeen kirjoittamista käytiin läpi piirilevyn läpikuparoinnissa tarvittavat 

kemikaalit. Myös jyrsimen käyttöohjeeseen tutustuttiin. 

2.2 Työohjeen rakenne 

Toimiva työohje on selkeä, kattava sekä yksityiskohtainen. Toimivan työohjeen 

avulla kenen tahansa alan ammattilaisen tai opiskelijan pitäisi pystyä tekemään 

työ ilman aikaisempaa kokemusta. Erilaisia tyylejä työohjeen kirjoittamiseen on 

useita, mutta seuraavaksi käydään läpi tässä työssä käytetty tyyli. Työohje on 

hyvin samanlainen tyyliltään kuin opinnäytetyö, sillä se on selkeä ja helposti 

ymmärrettävä. (1, s. 244–245.) 
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2.2.1 Otsikointi ja sisällys 

Työohjeen otsikon tulee kiteyttää selkeästi tehtävä työ. Työohjeen alussa on 

hyvä olla sisällysluettelo. Sisällysluettelo helpottaa yksittäisten työvaiheiden et-

simistä, jos esimerkiksi halutaan tarkistaa tietty työvaihe. Sisällysluettelopohja 

on vastaavanlainen kuin opinnäytetyössä. (1, s. 248, 299–300.)  

2.2.2 Johdanto 

Työohjeen johdannossa kerrotaan tiivistetysti työvaiheet, välineet sekä muut 

erityishuomiota vaativat toimenpiteet ennen työhön ryhtymistä. Näin vältytään 

yllätyksiltä kesken työn teon. Johdannossa on myös hyvä olla esimerkiksi kaa-

vio tai kuvaaja työvaiheista. Kuvaaja helpottaa ymmärtämään, minkälaisia työ-

vaiheita tuleva työ pitää sisällään. Kuvaajan vaiheet kannattaa nimetä samoin, 

kuin niille tarkoitetut kappaleet on työohjeessakin nimetty. Tällä helpotetaan 

ymmärtämään, mitä työvaihetta mikäkin kohta kuvaajassa tarkalleen tarkoittaa. 

(1, s. 248–254.) 

2.2.3 Kappalejako 

Työohjeen selkeyden kannalta on hyvä laittaa jokainen työvaihe omaksi kappa-

leekseen. Tarvittaessa kannattaa myös alaotsikoida kappaleita. Tällä tavoin 

helpotetaan tiettyjen kohtien löytämistä työohjeesta. Myös ulkoasusta tulee hy-

vin selkeä, kun kappalejako on tehty huolella. (1, s. 302–304.) 

2.2.4 Kuvitus 

Työohjeessa on hyvä olla kuvia eri työvaiheista selkeyttämässä asian ymmär-

rettävyyttä. Kuvat pitää nimetä selvästi, jotta työn tekijä tietää aina, mihin työn 

vaiheeseen ne liittyvät. On myös hyvä viitata tekstissä kuviin. Kuvina voi käyttää 

kuvan kaappauksia tietokoneelta, piirroksia tai valokuvia eri työvaiheista. (1, s. 

311.) 
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2.2.5 Varoitukset 

Työohjetta kirjoittaessa pyrittiin myös lisäämään työohjeeseen varoituksia, jos 

työssä ollaan tekemisissä vaarallisten kemikaalien tai laitteiden kanssa. Myös 

jos työssä käytettiin monimutkaisia laitteita, joiden toiminta vaati erityistä tietä-

mystä, työohjeeseen lisättiin huomautus lukijalle laitteiden käyttöohjeeseen tu-

tustumisesta ennen työn aloittamista. Näillä toimilla pyrittiin siihen, että työn 

suoritus olisi mahdollisimman turvallista sekä mahdollisilta laiterikoilta vältyttäi-

siin. 

2.3 Työohjeen käyttö 

Tässä työssä laaditun työohjeen tarkoitus on pääasiassa olla apuna piirilevyn 

valmistuksen opettelussa. Työohjetta voi myös käyttää, jos ammattikorkeakou-

lussa on laboratoriotyönä piirilevyn valmistus. Työohjetta on kuitenkin hyvä pi-

tää myöhemminkin mukana työtä tehdessä, jotta mikään työvaihe ei unohdu.  

Näin taataan aina ammattimaisesti ja huolella valmistetut piirilevyt. Työohjeen 

kirjoittamisen jälkeen on hyvä pyytää testihenkilöä valmistamaan piirilevy tämän 

uuden työohjeen perusteella tai pyytää ammattilaisen käymään työohje tarkasti 

läpi kohta kohdalta asiavirheiden varalta. Tällä selvitetään, että työohje on ym-

märrettävä ja helposti seurattava. (1, s. 49–56.) 
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3 PIIRILEVYMATERIAALIT JA JUOTOSTAVAT 

Piirilevyjen rakennemateriaalit jaetaan FR-luokan (flame retardant) eli palonkes-

tävyyden mukaan. Mitä isompi FR-luku materiaalilla on, sitä parempi palonkes-

tävyys piirilevyllä on. Kuvassa 1 on listattu eri FR-luokat sekä niiden ominaisuu-

det. (2.) 

   

KUVA 1. Piirilevyjen FR-luokat (3, s. 118) 
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3.1 Piirilevyjen rakennemateriaalit 

Piirilevyjen materiaalit vaikuttavat levyjen hintaan sekä laatuun. Piirilevymateri-

aali voidaan valita tuotteen käyttötarkoituksen mukaan. Yleisimpiä piirilevyjen 

rakennemateriaaleja ovat 

• epoksilasikuitu 

• polyimidi 

• fenolihartsi 

• keraamiset materiaalit. (2.) 

Epoksilasikuitu on yleisin piirilevyissä käytetty materiaali. Tämä materiaali on 

epoksimuovia, jota on vahvistettu lasikuidulla. Epoksilasikuidun lämpölaajene-

minen on vähäistä 125 °C:seen saakka, joka on yläraja tälle materiaalille. Tämä 

materiaali on mekaanisesti hyvin kestävää ja hinta on myös kohtuullinen. (2; 3, 

s. 118–123.) 

Polyimidi on ominaisuuksiltaan hyvin samanlainen kuin epoksilasikuitu, mutta 

siinä lämpölaajeneminen on pienempää. Polyimidi kestää lämpöä hyvin. Sen 

lasisiirtymälämpötila on 220 °C – 260 °C. Tämä materiaali on myös hyvin kestä-

vää mekaanisesti. Polyimidiä käytetään sotateollisuudessa sekä muissa käyttö-

kohteissa, joissa tarvitaan materiaalilta hyvää lämmönsietokykyä. (2; 3, s. 144.) 

Fenolihartsi on halpaa paperimassapohjaista materiaalia. Tätä materiaalia ei 

enää nykyisin käytetä. FR-2 koostuu fenolihartsista ja paperista. Leikkauksien ja 

reikien tekoon ei tarvita poraa. Fenolihartsi on mekaanisesti heikkoa, sillä se 

vääntyy ja murtuu hyvin helposti. Siinä on suuri lämpölaajenemiskerroin. Se ei 

myöskään kestä lämpöä hyvin ja folio kiinnittyy siihen huonosti. (2; 3, s. 143.) 

Keraamisia piirilevymateriaaleja on useita. Yleisin niistä on alumiinioksidi. Ke-

raamisilla materiaaleilla on hyvin pieni lämpölaajenemiskerroin (sama kuin ke-

raamisilla komponenteilla). Lämmönjohtavuus keraamisilla materiaaleilla on 

hyvä, mutta siitä voi olla haittaa juotosvaiheen aikana. Mekaanisesti nämä ma-

teriaalit ovat heikkoja, sillä ne murtuvat helposti. (2; 3, s. 103.) 
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3.2 FR-4-piirilevymateriaali 

Yleisin käytetty piirilevymateriaali on FR-4-epoksilasikuitu. Se koostuu lasikui-

tusäikeistä sekä epoksihartsista. Tällä piirilevymateriaalilla on hyvät mekaaniset 

sekä sähköiset ominaisuudet. Myös lämmönsietokyky on FR-4-materiaalilla hy-

vä. Sen lasisiirtymälämpötila Tg voi vaihdella välillä 110 °C – 200 °C. Materiaalin 

palamisenesto-ominaisuuksia voidaan muokata fosforipohjaisilla aineilla, alu-

miinihydroksidilla sekä ei-halogeenipohjaisilla aineilla. FR-4-materiaalin ha-

joamislämpötila Td on yleensä noin 320 °C. Edellä mainittujen ominaisuuksien 

ansiosta FR-4-materiaalia käytetäänkin usein esimerkiksi autoissa, tietokoneis-

sa ja matkapuhelimissa sekä muissa vaativissa käyttökohteissa. FR-4-

materiaalin tuottaminen on halpaa sekä yksinkertaista, sillä siinä olevia materi-

aaleja epoksihartsia sekä lasikuitukudosta käytetään muuallakin kuin teollisuu-

den tuotteissa. Kuvassa 3 on FR-4 materiaalin ominaisuuksia. (2; 3, s. 118, 

127–128; 4; 5; 6.) 

 

 

KUVA 3. FR-4-materiaalin ominaisuuksia (3, s. 167) 

3.3 Piirilevyjen rakenne 

Piirilevyjen rakenteita on useita erilaisia. Rakenne määräytyy levyn käyttökoh-

teen mukaan. Yksinkertaisissa käyttökohteissa riittää yksi kerros, kun taas mo-

nimutkaisemmat käyttökohteet tarvitsevat useampia kerroksia piirilevyssä, jotta 

vaativimmatkin kytkennät saataisiin suoritettua. (2.) 
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3.3.1 Yksikerrosrakenne 

Yksikerrosrakenteessa voidaan käyttää yksipuoleista kuparointia, jossa kupa-

rointi tulee vain piirilevyn yhdelle puolelle. Tällainen kuparointi on hyvin helppo 

ja halpa suunnitella sekä toteuttaa. Näin ollen se sopiikin yksinkertaisiin käyttö-

kohteisiin. Myös massatuotannossa tämä rakenne on hyvin hyödyllinen. Yksi-

puolisessa kuparoinnissa reikään asennettavien komponenttien juotosten luo-

tettavuus on huono, mutta sitä voi parantaa läpikuparoinnilla. (2; 3, s. 106–107.) 

Yksikerrosrakenteessa on myös mahdollista käyttää kaksipuoleista kuparointia. 

Tässä kuparointi tulee piirilevyn molemmille puolille. Eri kuparikerrokset yhdiste-

tään toisiinsa läpikuparointia käyttäen. Luotettavuus komponenttien juotoksissa 

on tämän ansiosta hyvä. (2; 3, s. 106–107.) 

3.3.2 Monikerrosrakenne 

Monikerrosrakenteessa johdinvetoja on mahdollista olla piirilevyn sisällä. Tälläi-

nen rakenne saadaan aikaan liittämällä useita yksikerroslevyjä päällekkäin. Ker-

roksia on mahdollista olla useita kymmeniä, mutta yleensä käytetään 4–10 ker-

rosta. Monimutkaisiin kytkentöihin on käytännössä pakko käyttää monikerrosra-

kennetta. Monikerrosrakenteessa on kolmea erilaista läpivientiä: 

• kätketty läpivienti 

• sokea läpivienti 

• läpikulkeva läpivienti (kuva 2). (2; 3, s. 107–109.) 
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KUVA 2. Erilaiset läpiviennit (2) 

 

Kätketty läpivienti yhdistää levyn sisällä olevia kerroksia. Tätä läpivientiä ei näy 

ulospäin ollenkaan. Sokea läpivienti on havaittavissa vain levyn toiselta puolel-

ta, eli läpivienti ulottuu levyllä esimerkiksi ylimmän kerroksen, mutta ei koko le-

vyn läpi. Läpikulkeva läpivienti menee läpi koko levystä. (2; 3, s. 108–109.) 

3.4 Lämmönjohtavuus ja sähköiset ominaisuudet 

Piirilevymateriaaleja jaetaan eri luokkiin niiden lämpölaajenemiskertoimien mu-

kaan. Lasisiirtymälämpötila Tg on lämpötila, jossa piirilevyn hartsi muuttuu ko-

vasta ja lasimaisesta pehmeäksi. Lämmitys yli materiaalin lasisiirtymälämpötilan 

ei tuhoa sen ominaisuuksia, vaan ne palaavat ennalleen lämpötilan laskettua. 

Lämpölaajeneminen on erilaista eri akseleilla. Tämä johtuu lasikuidun kutomis-

suunnasta. Käsiteltäviä akseleita ovat x, y ja z. (3, s. 123–124; 11, s. 285, 335.) 

Hajoamislämpötila Td tarkoittaa lämpötilaa, jossa materiaali menettää painoaan 

kemiallisten sidosten pettämisen myötä. Td arvo on se lämpötila, jossa materi-

aali on menettänyt 5 % alkuperäisestä painostaan. (3, s. 126–127.) 
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Time to delamination -arvo tarkoittaa tietynlaisissa testeissä saatua aikaa, jolla 

esitetään tietyn piirilevymateriaalin kyky vastustaa hajoamista. Näissä testeissä 

materiaalia lämmitetään 266 °C:seen, 280 °C:seen tai 300 °C:seen termokemi-

allisessa analysaattorissa ja mitataan aikaa, kuinka kauan materiaali kestää, 

ennen kuin se alkaa kupruilla ja sen liitokset hajota. (3, s. 126–127, 170–172.) 

Piirilevyillä on dielektrisyyskerroin, jolla kuvataan piirilevyn ominaisuuksia toimia 

eristeenä. Dielektrisyyskertoimeen voivat vaikuttaa kosteus, taajuus sekä läm-

pötila. Samallakin materiaalilla voi siis olla hieman eri dielektrisyyskerroin edellä 

mainituista tekijöistä riippuen. Dielektrisyyskerroin vaihtelee FR-4-materiaaleilla 

sekä eri olosuhteissa 3,7–4,7:n välillä. (3, s. 177–178.) 

3.5 Fyysinen kestävyys 

Piirilevymateriaalien mekaanisia ominaisuuksia testataan usealla eri tavalla. 

Näitä tapoja ovat kuparin kuorintalujuus, taivutuslujuus, kosteuden imeytyminen 

sekä materiaalin kemiallinen kestävyys. (3, s. 170–180.) 

Kuparin kuorintalujuutta testaan, jotta saadaan selville, kuinka tiukasti kupari on 

kiinni laminaatissa. Kuparin kuorintalujuustestejä tehdään eri lämpötiloissa sekä 

materiaalin altistuttua eri kemikaaleille. Tässä testissä kuparia kuoritaan irti la-

minaatista. Sitten kuoritun kuparin päähän asetetaan mittari, jolla mitataan kuin-

ka paljon voimaa kuparin irti repiminen vaatii. Lopputulos lasketaan jakamalla 

minimikuorma kuoritun kaistaleen leveydellä. 

Taivutuslujuutta testataan, jotta saadaan selville, kuinka paljon taivutusta mate-

riaali kestää, ennen kuin se katkeaa. Taivutuslujuustestissä levy asetetaan tuki-

en päälle ja levyn keskelle laitetaan tietyn painoinen kuorma. Kuormana voi-

daan käyttää myös laitetta, jonka voimaa voidaan säätää. (3, s. 175.) 
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Kosteuden imeytymistestejä on tärkeä tehdä, sillä kosteus voi aiheuttaa vikoja 

imeytyessään materiaaliin. Tässä testissä piirilevymateriaali upotetaan veteen 

24 tunniksi. Tämän jälkeen se kuivataan ja punnitaan. Sitten levy upotetaan 

veteen uudelleen ja mittaus suoritetaan uudelleen. Näitä tuloksia vertaamalla 

saadaan selville, kuinka paljon nestettä materiaaliin imeytyy. (3, s. 175–176.) 

Piirilevymateriaalin kemiallisen kestävyyden testi on lähes sama kuin kosteuden 

imeytymisen. Tässä testissä piirilevymateriaali upotetaan veden sijasta mety-

leenikloridiin. Tämän jälkeen tarkastellaan, kuinka paljon tätä kemikaalia imey-

tyy piirilevymateriaaliin. (3, s. 176.) 

3.6 Juotostekniikat 

Piirilevyjen juottamiseen on useita eri tekniikoita. Juotostekniikka valitaan usein 

komponenttien sekä piirilevymateriaalien mukaan. Piirilevysuunnittelussa on 

myös huomioitava, mitä juotostapaa tullaan käyttämään. Seuraavaksi on esitel-

ty yleisimpiä juotostekniikoita: 

• aaltojuotos 

• höyryfaasijuotos 

• infrapunajuotos 

• kuumahihnajuotos 

• kuumailmajuotos. (2.) 

Aaltojuotos on tarkoitettu lähinnä reikään asennettaville komponenteille, joten 

jos aiotaan käyttää pintaliitoskomponentteja, se täytyy huomioida jo piirilevyä 

suunnitellessa. Aaltojuotos ei vaadi erillistä juotospastaa. (2.) 

Höyryfaasijuotoksessa juotospasta sulatetaan piirilevylle erikoisnesteen höyrys-

sä. Höyryn lämpötila on noin 200 °C. Juotospasta on pehmeää ja raemaista. 

Lämmitettäessä juotospastaa tarpeeksi se sulaa. Kun juotospasta taas jäähtyy, 

se kovettuu ja näin saadaan komponentti tukevasti juotettua. Höyryfaasijuotosta 

käytetään pintaliitostekniikassa. Tämä juotostekniikka on hitaampi kuin aalto-

juotos. (2.) 
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Infrapunajuottamisessa juotospasta sulatetaan piirilevylle valolla tai säteilyllä. 

Komponenttien sijoittelussa pitää huomioida, että mikään komponentti ei varjos-

ta toisen komponentin juotoskohtaa. Tällä tavoin taataan se, että kaikki kom-

ponentit saavat saman verran lämpösäteilyä. (2.) 

Kuumahihnajuottamista käytetään ainoastaan keraamisille piirilevyille. Tässä 

juotostekniikassa piirilevyä lämmitetään altapäin. Näin piirilevyn päällä oleva 

juotospasta sulaa levylle. (2.) 

Kuumailmajuotos on nykyisin teollisuudessa eniten käytetty juotosmenetelmä. 

Juottaminen tapahtuu kuumailmavyöhykeuuneissa, joiden sisällä levy kulkee 

liukuhihnalla. Uunien eri osissa on useita eri lämpötiloja, joita juotoksessa tarvi-

taan. (2.) 
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4 KAKSIKERROSPIIRILEVYN VALMISTUS OAMK:SSA 

Kaksikerrospiirilevyn valmistus sisältää useita eri työvaiheita. Työvaiheet on 

kuvattu kuvassa 4 vasemmalta ylhäältä alkaen. Työvaiheet ovat tarkemmin esi-

teltynä itse työohjeessa (liite 1). 

KUVA 4. Työvaiheet 

4.1 Tiedostojen tuonti ja käsittely 

Tiedostojen tuonnilla tarkoitetaan asiakkaalta saadun piirilevyn layoutin avaa-

mista CircuitCam-ohjelmalla. CircuitCam on ohjelma, jota käytetään piirilevyn 

valmistuksessa. CircuitCamilla muokataan esimerkiksi piirilevyn suunnitteluun 

tarkoitettujen ohjelmien, kuten OrCAD tai Eagle, avulla piirrettyjä piirilevyn 

layouteja. CircuitCamilla määrätään, mitä jyrsitään ja millä terillä jyrsitään. En-

simmäisenä ohjelmalla muokataan jyrsintään käytettävät terät siten, että erilai-

sia teriä tarvitsisi käyttää mahdollisimman vähän.  
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Seuraavaksi on vuorossa insulointivaihe. Tässä vaiheessa poistetaan turhat 

jyrsittävät alueet, kuten esimerkiksi reunaviivan jyrsintää ei tarvitse suorittaa 

piirilevyn jokaiselle kerrokselle. Tässä työvaiheessa voi myös muokata piirilevyl-

le tulevien pädien, eli piirilevyllä olevien juotoskohtien kokoa sekä asentoa tar-

vittaessa. Työvaiheet toistetaan levyn jokaiselle kerrokselle. Tavoitteena näillä 

toimenpiteillä on vähentää turhaa jyrsintätyötä, jolloin piirilevyn hinta pysyy ma-

talampana. Lopuksi CircuitCamilla määritetään vielä levyn irrotus aihiosta. Näi-

den työvaiheiden jälkeen tarkastetaan, että kaikki on kunnossa, ja luodaan 

BoardMaster-ohjelmalle menevä tiedosto. Kuvassa 5 näkyy yleiskatsaus Cir-

cuitCam-ohjelmasta. 

 

KUVA 5. CircuitCam-ohjelman käyttöliittymä 

4.2 Reikien poraus 

Piirilevyyn porataan reiät jyrsimellä ennen läpikuparointia. Jyrsimenä käytetään 

LPKF ProtoMat S100 -laitetta (kuva 6). Jyrsin ei käytä uusinta lasertekniikkaa 

vaan vanhempaa terillä tehtävää jyrsintää. Suurin ero laserlaitteisiin on nopeu-

dessa sekä desibeleissä. Laserlaitteet ovat huomattavasti nopeampia sekä hil-

jaisempia. 
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KUVA 6. LPKF ProtoMat S100 -jyrsin 

Tämä jyrsimen terän pyörimisnopeus on jopa 100 000 rpm, joten jyrsinnän laatu 

ja nopeus ovat hyviä. Jyrsimessä on makasiini kymmenelle terälle. Laite vaihtaa 

itse tarvittavan terän makasiinista. Tämä nopeuttaa työn tekemistä, sillä työtä ei 

tarvitse keskeyttää manuaalisen teränvaihdon ajaksi. Kuvassa 7 näkyy jyrsimen 

terämakasiini. Terät ovat merkattuna sekä terän koodilla että myös erivärisellä 

renkaalla terän ympärillä. Eri värikoodit tarkoittavat eri käyttötarkoitusta terälle. 

Näitä käyttötarkoituksia voivat olla esimerkiksi reikien poraus, itse jyrsintä tai 

levyn irrotus aihiosta. Kuvassa 8 näkyy teriä, joita esimerkiksi voidaan käyttää 

jyrsintätöissä. Terät valmistetaan yleensä kovametallista, joka on komposiittima-

teriaali. Se tehdään volfram-karbidista ja sidosaineena toimii koboltti. Kovame-

talli kestää kulumista jopa 100 kertaa paremmin terästyökaluihin verrattuna.  

Terien täytyy olla hyvin teräviä, jotta reiät olisivat siistejä eikä poraus repisi piiri-

levyn pintaa. (7; 8, s. 94; 13.) 
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KUVA 7. Jyrsimen terämakasiini 

 

KUVA 8. Jyrsimen teriä 
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Jyrsimessä käytetään ilmanpainetallaa, jolla taataan se, että piirilevyyn ei koske 

mikään muu kuin laitteen jyrsintäterä. Tämä estää piirilevyn naarmuuntumisen. 

Piirilevyn aihio kiinnitetään jyrsimeen vakuumilla, joten mitään kiinnitysosia ei 

tarvita. Jyrsinnän laadunseuranta on helppoa reaaliajassa, sillä laitteessa on 

terän yläpuolella valo, jonka ansiosta työstettävään kohtaan ei tule varjoja. 

Myös jyrsimen suojakansi on läpinäkyvä. Jyrsin on myös turvallinen, sillä terä ei 

ala pyöriä, jos kansi on auki, ja työ keskeytyy heti, jos kannen avaa yllättäen. 

On huomioitava, että jos kannen avaa kesken työn, BoardMaster saa virhekoo-

din. Tämä virhekoodi voi olla niin paha, että jyrsinnän voi joutua aloittamaan 

kokonaan alusta. 

ProtoMat S100 -jyrsin liitetään tietokoneeseen normaalilla USB 2.0 -kaapelilla. 

Laitteessa on piirilevyn kohdistamiseen käytettävä kamera, jonka kuvan näkee 

tietokoneen ruudulta BoardMaster-ohjelmalla. Kameran avulla kohdistaminen 

sujuu lähes automaattisesti. (7.) 

BoardMaster on ohjelma, jolla hallitaan jyrsintä. BoardMasterilla avataan Cir-

cuitCamilla luotu työtiedosto. Piirilevy tulee näkyviin BoardMasteriin.  Board-

Masterilla ohjataan jyrsin poraamaan kaikki piirilevyn läpi menevät reiät, jonka 

jälkeen levy läpikuparoidaan. 

4.3 Läpikuparointi 

Läpikuparointiin käytetään LPKF Contact -läpikuparointilaitetta (kuva 9). Tällä 

laitteella läpikuparointi tapahtuu kemiallisesti happoliuoksessa. Läpikuparoinnin 

tarkoituksena on muodostaa kuparia piirilevylle porattujen reikien sisäpinnalle, 

jotta sähkövirta kulkisi niiden kautta. 
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KUVA 9. LPKF Contact -läpikuparointilaite 

Läpikuparoinnissa on kolme työvaihetta. Ensimmäisessä vaiheessa levy puh-

distetaan kahdessa eri pesuaineliuoksessa, jotta kaikki epäpuhtaudet kuten 

rasva ja muu levyn pintaan tarttunut lika saadaan varmasti pois. Käytettäviä 

pesuaineita voivat esimerkiksi olla LPKF Cleaner 110 ja LPKF Cleaner 210. 

Levy pestään useaan kertaan työvaiheiden välissä. Seuraava työvaihe on akti-

vaattorin lisäys. Levyä pidetään aktivaattoriliuoksessa, jotta aktivaattoria menisi 

jokaisen reiän sisäpinnalle. Aktivaattorina käytetään LPKF Activator 310          

-ainetta. Aktivaattori on hiilipitoista kemikaalia. 
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Hiili johtaa sähköä, joten tämän aineen tartuttua levyn reikien sisäpinnalle niistä 

tulee sähköä johtavia ja näin ollen myöhemmässä työvaiheessa saadaan elekt-

rolyysi alkuun myös reikien sisäpinnalla. Tämän työvaiheen jälkeen levyn pinta 

puhdistetaan tislatulla vedellä. Veden pitää olla tislattua, jotta siinä ei olisi epä-

puhtauksia, kuten kvartsia, kalsiumia, rautaa, kloridia ja magnesiumia, jotka voi-

vat olla haitaksi läpikuparoinnissa. Kuvassa 10 levy on otettu aktvaattoriliuok-

sesta ja sen pinnasta pyyhitään ylimääräinen aine pois lastalla. 

KUVA 10. Ylimääräinen aktivaattori pyyhitään pois levyn pinnasta lastalla 

Viimeinen työvaihe on itse kuparointi. Elektrolyyttinen kuparointi tapahtuu siis 

liuoksessa, joka sisältää muun muassa rikkihappoa sekä suolahappoa. Liuok-

sen pohjalla on kupariharkko. Jotta kupari saataisiin tarttumaan levylle, kiinnite-

tään levyyn kaapeli, jonka kautta siihen annetaan sähkövirtaa. Myös liuoksessa 

olevalle kupariharkolle johdetaan sähkövirtaa. Sopiva sähkövirran suuruus on 

noin 6–8 ampeeria. Jännite pidetään noin 0,5 voltissa.  
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Kuparin muodostuminen levyn reikiin kestää noin kaksi tuntia. Itse työohjeessa 

on tarkemmin mainittu työturvallisuudesta kemikaalien käsittelyssä. 

Piirilevyn läpikuparointi perustuu elektrolyysiin. Elektrolyysi on kemiallinen reak-

tio, jossa tapahtuu hapettumispelkistymisreaktio laittamalla sähkövirta kulke-

maan ioneja sisältävän liuoksen lävitse (kuva 11). Tässä tapauksessa liuos si-

sältää muun muassa suola- ja rikkihappoa. Kuparin muodostuminen tapahtuu 

katodilla, joka on negatiivisesti varautunut. Se vastaanottaa positiivisia ioneja, 

jotka sitten pelkistyvät. Liuoksessa on rikkihappoa siitä syystä, että se johtaisi 

paremmin sähköä. Kuparoinnin tasaisuuteen eli laatuun vaikuttavat liuoksen 

lämpötila, liuoksen puhtaus, aika sekä virran tasainen jakautuminen piirilevylle. 

(3; 9, s. 1–4, 6–7; 10; 11, s. 196; 11.) 

 

KUVA 11. Sähkökemiallinen kuparointi (11, s. 196) 
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4.4 Jyrsintä 

Jyrsintä vaiheessa CircuitCamilla luotu työtiedosto avataan BoardMaster-

ohjelmalla. BoardMaster on kattava jyrsimen hallintaohjelma. BoardMasterissa 

näkyy kuvaa jyrsimessä olevasta kamerasta. Tämän kuvan sekä aikaisemmin 

porattujen kohdistusreikien avulla on helppo kohdistaa levy aina oikeaan paik-

kaan sen jälkeen, kun sitä on siirrelty. BoardMaster ilmoittaa myös, jos jokin 

terä on loppuun käytetty tai jos jyrsimen makasiinissa ei ole tarvittavia teriä. En-

nen jyrsinnän aloittamista voidaan BoardMasterilla manuaalisesti jyrsiä pieni 

testialue, jotta nähdään, onko jyrsintäsyvyys oikea. Kun syvyys on säädetty oi-

keaksi, itse jyrsintä hoituu täysin automaattisesti BoardMasterin avulla. Ainoas-

taan levyn kääntäminen täytyy hoitaa manuaalisesti. Ohjelma ilmoittaa, kun jyr-

sintä on valmis, sekä siihen kuluneen ajan. Kuvassa 12 on juuri aloitettu jyrsin-

tätyö. 

KUVA 12. Jyrsinnän aloitus 
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4.5 Juotteenestopinnoite 

Juotteenestopinnoitteen tarkoituksena on estää tinan tai muiden juotosaineiden 

tarttumista muualle kuin halutuille alueille piirilevyssä. Tällä vähennetään oi-

kosulkujen sekä muiden virheiden määrää komponentteja juottaessa. Levyn 

pintaan levitetään telalla kovetinaineesta ja väriaineesta tehty seos. Tässä 

seoksessa oleva kovetinaine on UV-herkkää. Lämmitysuunin sekä UV-valotus-

laitteen avulla juotteenestopinnoite kovetetaan levyn pintaan. Lämmitysuunissa 

levy lämmitetään 80 °C:seen sen jälkeen, kun väri- ja kovetusaine on levitetty 

levyn pintaan. Lämmityksen jälkeen levy asetetaan UV-valotuslaitteeseen. Valo-

tusaika, jolla UV-herkkä aine kovettuu, on noin yksi minuutti. Valotusvaiheessa 

on kuitenkin muistettava suojata alueet, joihin aineen ei haluta kovettuvan. Näi-

tä alueita ovat esimerkiksi juotosalueet. Kuvassa 13 on LPKF:n UV-valotuslaite 

sekä pädien suojaamiseen käytettäviä kalvoja. 

 

KUVA 13. LPKF:n UV-valotuslaite 
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UV-valotuksen jälkeen levyn pinnasta pestään kovettumaton aine pois käyttäen 

vettä sekä LPKF Developer -ainetta, joka on natriumkarbonaattia eli soodaa. 

Pesun jälkeen levy lämmitetään vielä 160 °C:seen lämmitysuunissa.  On huo-

mioitavaa, että käytetyt pensselit ja astiat on puhdistettava asianmukaisesti käy-

tön jälkeen. Puhdistamiseen käytetään vettä sekä LPKF Conditioner -ainetta, 

joka on sitruunahappoa. 

4.6 Viimeistely 

Viimeinen vaihe piirilevyn valmistuksessa on levyn irrotus aihiosta. Tämä toi-

menpide suoritetaan jyrsimellä BoardMasteria käyttäen. Jyrsin irrottaa levyn 

CircuitCamissa määrätyllä tavalla aihiosta. Yleensä jätetään yksi kulma leik-

kaamatta, jotta levy pysyisi paikoillaan koko työn ajan. Viimeinen kulma irrote-

taan käsin kääntämällä. Lopuksi on hyvä vielä hioa terävät reunat levystä turval-

lisuuden vuoksi. Näin piirilevy on saatu valmiiksi. 
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5 POSTERI JA VIDEO 

Työohjeen lisäksi tehtiin posteri sekä video piirilevyn valmistamisesta Oulun 

seudun ammattikorkeakoulussa. Näitä käytetään havainnollistamaan asiakkaal-

le, miten piirilevyn valmistus pääpiirteittäin tapahtuu. 

5.1 Posteri 

Postereita tehtiin kaksi kappaletta, toinen suomeksi ja toinen englanniksi (liite 2 

ja 3). Postereista käy ilmi selkeästi eri työvaiheet piirilevyn valmistuksessa. Asi-

an selkeyttämiseksi sekä postereiden visuaalisen ilmeen parantamiseksi niihin 

sijoitettiin kuvia eri työvaiheista. On myös tärkeää ottaa huomioon lukijoiden 

tietämys asiasta. Postereihin vältettiin kirjoittamasta liian monimutkaisia tai yksi-

tyiskohtaisia asioita. Myös ammattisanastoa vältettiin jos mahdollista. Posterit 

ovat nähtävissä Oulun seudun ammattikorkeakoulun käytävällä olevalta näytöl-

tä. 

5.2 Video 

Video on hyvä lisä esimerkiksi esiteltäessä piirilevyn valmistusta. Video löytyy 

Oulun seudun ammattikorkeakoulun piirilevyjen tuotantosivuilta osoitteesta: 

http://www.oamk.fi/~alatvale/piirilevyt. Videon kuvasi ja editoi Oulun seudun 

ammattikorkeakoulun Viestintäpalvelut eli VIP, sillä heillä on alan osaamista 

sekä tarvittavat laitteet. 

Ennen kuvaamista täytyi käydä läpi, mitä osia työvaiheista on tärkeä näkyä vi-

deolla, jotta asiakas saisi selkeän kuvan tehtävästä työstä. Oli myös tärkeä 

käydä tarkastamassa kuvauspaikat etukäteen, jotta valaistus sekä kuvakulmat 

saatiin selvitettyä. Kuvaaminen tapahtui samalla, kun piirilevyä valmistettiin asi-

akkaalle. Näin ollen uusintaottoja ei juurikaan voitu tehdä. Jokaisesta työvai-

heesta kuvattiin pätkiä, jotka sitten editoitiin yhdeksi noin kahden minuutin mit-

taiseksi videoksi. 
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6 YHTEENVETO 

Opinnäytetyössä kirjoitettiin työohje piirilevyn valmistukseen sekä tehtiin suo-

men- ja englanninkielinen posteri ja video piirilevyn valmistamisesta Oulun seu-

dun ammattikorkeakoulussa. Töiden tilaajana toimi Oulun seudun ammattikor-

keakoulun Protopaja. 

Työohje toimii apuna piirilevyn valmistusta harjoitellessa sekä myöhemmin 

muistiapuna työtä tehdessä. Työohjeen pitää olla hyvin yksityiskohtainen ja 

tarkka. Selkeyttä ohjeeseen lisäsi kuvankaappaukset sekä valokuvat eri työvai-

heista. Posterin ja videon tarkoitus on esitellä asiakkaille, miten piirilevyn val-

mistus Oulun seudun ammattikorkeakoulussa pääpiirteittäin tapahtuu. Posteri 

piti tehdä sekä suomeksi että englanniksi. Postereiden ulkoasua saatiin paran-

nettua valokuvilla eri työvaiheista. Videon kuvasi ja editoi Oulun seudun ammat-

tikorkeakoulun Viestintäpalvelu, joilla on alan kokemusta sekä ammattikäyttöön 

tarkoitetut laitteet. Tästä syystä videosta tuli selkeä, tyylikäs ja ammattimainen. 

Haluttuihin tuloksiin päästiin. Työ eteni suunnitellulla tavalla alusta loppuun ja 

suuremmilta ongelmilta vältyttiin. Kaikki osapuolet olivat tyytyväisiä tuloksiin. 

Työn alussa seurattiin ammattilaisen työtä ja kirjoitettiin muistiinpanoja. Tämä 

toimi hyvänä pohjana työohjeen kirjoittamiseen. Työtä tehdessä opittiin paljon 

uutta asiaa kaksikerrospiirilevyn valmistamisesta, sillä kaikki käytetyt laitteet 

olivat ennestään täysin tuntemattomia. Kirjoittaessa jouduttiin tutustumaan 

myös laitteiden käyttöohjeisiin. Tällä tavoin saatiin parempi kuva laitteiden ja 

kemikaalien turvallisuutta koskevista asioista. Työtä voisi kehittää pidemmälle 

tekemällä kehityssuunnitelman itse piirilevyn valmistukseen. Se voisi sisältää 

esimerkiksi suunnitelman siitä, miten tuotannon tehokkuutta voitaisiin lisätä ja 

näin ollen hankkia lisää asiakkaita. 
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1 JOHDANTO 

Tämä on työohje kaksikerrospiirilevyn valmistukselle jyrsimällä. Työssä käyte-

tään Windows-ohjelmia CircuitCam ja BoardMaster. Muita työssä käytettäviä 

välineitä ovat LPK ProtoMat S100 -jyrsin, LPKF Contact -läpikuparointilaite, 

lämmitysuuni sekä LPKF:n UV-valotuslaite. Tässä työohjeessa on yksityiskoh-

taisesti vaihe vaiheelta neuvottu, miten valmistaa kaksikerros piirilevy vaivatta ja 

ammattimaisesti. Kuvasta 1 näkyvät valmistuksen eri työvaiheet. 

KUVA 1. Työvaiheet 
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2 TYÖOHJE 

Seuraa työohjetta tarkkaan. Työohjeessa on kuvankaappauksia apuna selven-

tämään työvaiheita. Tarvittaessa kysy apua asiantuntijalta.  

2.1 Import 

Ensimmäinen työvaihe on importointi eli tiedostojen tuonti CircuitCam -

ohjelmaan. Avataan CircuitCam-ohjelma tietokoneella. Aloitetaan tuomalla asi-

akkaalta saadut tiedostot CircuitCamiin. Tiedostot ovat erinimisiä riippuen oh-

jelmasta, jolla piirilevyä on suunniteltu. Ohjelmia, joilla piirilevyjä voi suunnitella, 

ovat esimerkiksi Eagle ja OrCAD. Tiedostopäätteitä voivat olla esimerkiksi .gts, 

.gbs, .drl, .gbr ja .gbl. 

On hyvä muistaa tallentaa työ usein, jotta ongelmatilanteissa on uusin var-

muuskopio aina tallella. Tiedostot avataan painamalla vasemmasta ylälaidasta 

”File -> Import” ja valitsemalla tarvittavat tiedostot. ”Preview”-kohdasta voi tar-

kistaa layerin eli kerroksen ennen sen tuontia. Ensimmäisenä valitaan .gbr, joka 

sisältää levyn reunaviivan. Sitten avataan ”layer”-valikosta ”Board Outline” ja 

painetaan ”Import”. Tämän jälkeen poistetaan ylimääräiset viivat ja jätetään jäl-

jelle vain reunaviiva. Seuraavana tuodaan .gbl-tiedosto ja valitaan layeriksi ”Bot-

tom Layer” eli niin sanottu juotospuoli. Sen jälkeen tuodaan .drl ja layeriksi vali-

taan ”Drillpladed”. Tässä vaiheessa on hyvä tarkistaa ”Size xy”-ruudusta, että 

levyn koko on oikea. On myös hyvä tarkistaa, että levyn reiät ovat oikeissa koh-

dissa. Seuraavana tuodaan .gtl-tiedosto ja layeriksi valitaan ”Top Layer”. Jos on 

tarvetta, ”List Of Apertures”-kohdasta voi muokata pädejä esim. jos pädit ovat 

väärässä asennossa yms. 
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Tämän jälkeen tuodaan .gbs-tiedosto ja valitaan layeriksi ”Soldermask Bottom”. 

Viimeisenä tiedostona tuodaan .gts ja layeriksi valitaan ”Soldermask Top” kuten 

kuvassa 2. Jos asiakas haluaa piirilevylle painettua tekstiä, tässä vaiheessa 

tuodaan niille tarkoitetut tiedostot. Tätä vaihetta ei ohjeen esimerkkityössä ole. 

KUVA 2. .gts-tiedoston tuonti  

Tässä vaiheessa on myös hyvä tarkistaa käytettävät terät ja muokata listaa tar-

vittaessa. Avataan ”Config -> Format Configurations -> Excellon Tool List”. 

Sieltä valitaan ”Ncdrill Default”. Aukeaa kuvan 3 mukainen ikkuna, jossa näky-

vät käytettävät poranterät. Jos listassa on turhan paljon eri teriä pienillä ko-

koeroilla, kokoja voi pyöristää ylös- tai alaspäin, että saadaan vähennettyä teri-

en määrää. 
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KUVA 3. NCDrillDefault-valikko 

2.2 Insulointi 

Importoinnin jälkeen seuraava työvaihe on insulointi. Aloitetaan valitsemalla 

”View -> layers”. Sieltä valitaan layerit yksi kerrallaan. Valinta tapahtuu poista-

malla ruksit muiden kuin käsiteltävän layerin ”visible”-laatikosta, kuten kuvassa 

4 on nähtävissä. Käsiteltäviä layereitä ovat esimerkiksi top, bottom, drill, mask 

ja outline. 
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KUVA 4. Layerit eli kerrokset 

Jos ohjelma on piirtänyt levyn jokaiselle kerrokselle reunaviivan, se täytyy pois-

taa. Tämä toimenpide tehdään sen takia, että saadaan turhat jyrsinnät minimiin.  

Piirilevyn valmistuksessa laskutus perustuu jyrsinnän määrään. Jos on tarvetta 

säätää pädien kokoja, avataan kuvan 5 mukaisesti ”Config -> Format Configu-

rations -> Gerber - Aperture List”. Sieltä valitaan tarvittavat Aperture-listat. 

Yleensä nämä ovat ”Gerber Default”, ”Gerber default1” ja ”Gerber default2”. 

Ylhäällä näkyy alasvetovalikossa layer, aperture-lista ja valittu pädi. Kuvan 6 

mukaisesti klikattaessa hiiren oikealla haluttua pädiä Aperture-listalta ohjelma 

avaa tiedot valitusta pädistä. Tätä kautta voi esimerkiksi muokata pädien kokoa. 
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KUVA 5. Gerber – Aperture List

KUVA 6. Valitun pädin tiedot 
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Seuraavaksi avataan ”Edit -> Insulate” ja valitaan ”Bottom”. Laitetaan ruksi koh-

taan ”Remove Spikes” kuvan 7 mukaisesti. Tämä sen takia, että jyrsintävai-

heessa piirilevyltä poistetaan ”piikit” esimerkiksi jyrsintäkohtien välistä. Kuten 

kuvassa 8 nähdään, ”Tools”-valikosta valitaan käytettävät terät/teräkoot. 

”Width”-kohdasta voi muuttaa eristeväliä ja pädien ympärillä olevaa väliä. Lo-

puksi painetaan ”RUN”. Sen jälkeen tarkistetaan, että kaikki näyttää siltä miltä 

pitääkin.  

KUVA 7. Insulate Main -valikko 
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KUVA 8. Insulate Advanced -valikko 

Nämä insulointivaiheet toistetaan jokaiselle kerrokselle (layerille). Jos piirilevylle 

halutaan jyrsimellä tehtävää tekstiä, valitaan halutut tekstit ja alasvetovalikosta 

valitaan layeriksi ”Text Top” tai ”Text Bottom” sen mukaan kummalla puolella 

teksti on. Jos tekstien päällä on ylimääräisiä jyrsintä kohtia, ne voidaan poistaa. 

2.3 Levyn aihiosta irrotuksen säätö 

Seuraavana työvaiheena on säätää ohjelmalla levyn irrotus aihiosta. Valitaan 

alasvetovalikosta ”Board outline”. Työkaluksi valitaan ”Contour routing”. Ohjel-

ma avaa ikkunan, josta valitaan ”outside”. Tämä valikko näkyy kuvassa 9. Sitten 

painetaan ”RUN”. Seuraavaksi klikataan hiirellä levyn reunaviivaa esimerkiksi 

vasemmasta yläkulmasta. 
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Tämä aktivoi kulman. Sitten valitaan ”Breakout Tab” ja näin valittuun kohtaan 

reunaviivalla tulee ”lovi”. Tämä estää levyä tippumasta aihiosta, kun reunaviivaa 

leikataan. Sama työvaihe toistetaan myös toiseen yläkulmaan. 

KUVA 9. Contour Routing -valikko 

2.4 Tarkistus 

”View”-valikosta ”View Layers”-kohdasta laitetaan näkyviin muokattuja kerroksia 

(Drill Solder Mask Top ja Bottom) ruksaamalla kohdat ”Visible” ja ”Selectable”. 

Sitten tarkistetaan, että juotteenestopinnoite (solder mask) ja reiät ovat oikeilla 

paikoilla. Lopuksi laitetaan näkyviin bottom- ja insulointikerrokset. 
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2.5 Export 

Viimeinen työvaihe CircuitCamilla on valmiiden tiedostojen ”tulostus” eli expor-

tointi. Valitaan ”File -> Export -> LPKF -> LPKF Circuit Board Plotter” kuten 

kuvassa 10. Tämä luo .LMD-tiedoston. Ohjelma avaa raportin, josta näkee esi-

merkiksi jyrsittävät millimetrit sekä varoitukset, jos ohjelma huomaa jotain varoi-

tettavaa. Hinnoittelu siis tapahtuu jyrsittyjen millimetrien mukaan. 

KUVA 10. .LMD-tiedoston luonti 

2.6 BoardMaster 

Myös BoardMaster-ohjelmassa on suositeltavaa tallentaa työ usein. Työ tallen-

tuu .JOB-tiedostoksi. Aluksi laitetaan jyrsimeen virta, paineilma ja imuri päälle 

(imurin voi myös käynnistää vasta juuri ennen jyrsinnän aloittamista). Avataan 

BoardMaster-ohjelma, joka tarkastaa heti 0-kohdan jyrsimestä. BoardMaster 

kysyy, onko jyrsimessä terää.  
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Tämän jälkeen tulee tarkistaa, ettei jyrsimessä ole terää. Seuraavakasi tuodaan 

tiedostot BoardMasteriin valitsemalla kuvan 11 mukaisesti ”Import -> 

LMD/LPR”. Sieltä valitaan fiducial.LMD. Fiducial on kohdistusmerkki. Klikataan 

hiiren oikealla näppäimellä fiducialia (pieni neliö ruudun keskivaiheilla). Kun kli-

kataan, aukeaa ”Placement”, jolla muokataan asento. Ruudulle ilmestyy ”laatik-

ko”, joka siirretään keskelle apuviivojen avulla. Työvaihe näkyy kuvassa 12. 

Seuraavaksi avataan ”import -> LMD/LPR” ja sieltä valitaan työstettävä .LMD-

tiedosto eli tiedosto, joka tulostettiin (export) CircuitCamilla. Kun valinta on teh-

ty, ruudulle ilmestyy piirilevy. Levy siirretään myös keskelle. 

KUVA 11. Fiducial.LMD-tiedoston tuonti 
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KUVA 12. Placement-valikko 

Tämän jälkeen painetaan ruudun ylälaidassa olevaa ”P”-näppäintä, jolloin jyrsin 

menee niin sanottuun ”pause”-tilaan. Kun jyrsin on tässä tilassa, sen kansi voi-

daan aukaista ja laittaa aihio paikoilleen. Aihio laitetaan mahdollisimman keskel-

le apuviivojen avulla. Seuraavaksi tarkistetaan, että kohdistustiedosto osuu ai-

hiolle. Sen näkee kamerakuvasta oikealla ylhäällä olevasta ruudusta. Kuvassa 

näkyvä tumma alue on levyn reuna. Seuraavaksi tarkistetaan, osuuko jyrsittävä 

levy aihiolle. Tämä tehdään siirtämällä levyä koneella ja katsomalla jyrsimestä, 

että paineilmatalla on kokonaan aihion päällä. 

Seuraavassa työvaiheessa tehdään kohdistusmerkinnät piirilevyn nurkkiin. En-

sin valitaan alasvetovalikosta vasemmalta ylhäältä ”Marking Drills”. Sitten vali-

taan kaikki painamalla ”All+” ja painetaan ”Start”. Ohjelmassa aukeaa kuvan 13 

mukainen ikkuna, jossa ohjelma kysyy, tarviiko terää säätää.  
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KUVA 13. Tool Exchange 

Jos ei ole tarvetta säätää sitä, mennään eteenpäin. BoardMaster ilmoittaa, kun 

reiät ovat valmiit. Seuraavaksi valitaan alasvetovalikosta ”Drilling Plated”, jolla 

varsinaiset poraukset tehdään. Taas valitaan kaikki painamalla ”All+” ja aloite-

taan poraus painamalla ”Start”. Tässä vaiheessa ohjelma ilmoittaa, jos jyrsi-

messä ei ole oikean kokoisia teriä makasiinissa tai jos jollain terällä on jyrsitty 

sen maksimi jyrsintämäärä. Kuvissa 14 ja 15 on esitetty nämä vaiheet.  
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KUVA 14 Tarvittavaa terää ei ole makasiinissa 

KUVA 15. Terän jyrsintämillimetrit ovat täynnä 
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Jotta teriä voi lisätä, täytyy jyrsin laittaa pause-tilaan painamalla ”P”-näppäintä. 

BoardMasterissa aukeaa kuvan 16 mukainen ikkuna, jossa kerrotaan, mitä teriä 

työssä tarvitaan ja mitä teriä jyrsimen makasiinissa on tällä hetkellä. Laitetaan 

tarvittavat terät jyrsimen makasiiniin ja kerrotaan ohjelmalle, mitkä terät laitettiin 

ja mihin kohtaan makasiinissa. Sitten painetaan ”OK”, jolloin poraus alkaa. 

BoardMaster ilmoittaa, kun poraus on valmis. Sen jälkeen tarkistetaan silmä-

määräisesti, että reiät ovat läpi levystä. 

KUVA 16. Käytössä olevat ja tarvittavat terät  
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2.7 Läpikuparointi 

Seuraava työvaihe on läpikuparointi, jossa on tarkoitus saada kuparia myös 

reikien sisäpinnalle, jotta virta pystyisi kulkemaan levyn puolelta toiselle. Läpi-

kuparoinnissa käytettävä happo on syövyttävää, joten on suositeltavaa käyttää 

suojavälineitä ja noudattaa yleisiä työturvallisuusohjeita. Ensimmäiseksi levyn 

pinta hiotaan karhunkielellä. Karhunkieli poistaa hapettumat, epäpuhtaudet se-

kä poratessa tulleet ”kohoumat” levyn pinnasta. Tämän jälkeen levy kiinnitetään 

uittotelineeseen. Ensimmäisenä aineena on pesuaine ”Cleaner 110”. Pesuaine 

sekoitetaan ensin ja sitten levy lasketaan sinne hieman vinossa, jotta ainetta 

menisi myös reikiin ja ilmakuplan lähtisivät rei’istä pois. Painetaan ”motor”-

näppäintä, jolloin laite alkaa liikuttaa levyä edestakaisin liuoksessa. Annetaan 

levyn olla pesuaineessa noin 10 minuuttia.  

Kun levy on ollut 10 minuuttia altaassa, heilutus pysäytetään ”motor”-

näppäimestä ja levy nostetaan altaasta pois. Levy pestään huuhtelualtaassa. 

Pesun saa päälle ”spray1”-näppäimestä. Levy on pesussa noin 1 minuutin. 

Odotellessa sekoitetaan seuraava pesuaine, ”Cleaner 210”. 

Seuraavaksi levy lasketaan sinne noin 2 minuutiksi. Tässä altaassa levyä ei 

liikutella edestakaisin, joten ei tarvitse muuta kuin laskea levy altaaseen. Odo-

tellessa sekoitetaan seuraava aine eli ”Activator 310”. Kun levy on ollut tarvitta-

van ajan pesuaineliemessä, se kuivataan kuumailmapuhaltimella.  

Kuivauksen jälkeen levy lasketaan aktivaattoriin ja painetaan taas ”motor”-

näppäimestä levyn liikuttelu päälle. Aktivaattorissa levy on noin 5 minuuttia. Le-

vyn oltua aktivaattorissa tarvittava aika levyn liikuttelu pysäytetään ja levy nos-

tetaan poista altaasta. Seuraava työvaihe on levyn ”käsittely”. Ensin pyyhitään 

lastalla ylimääräinen aine pois levyn pinnasta.  
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Sitten otetaan tislattua vettä paperiin ja pyyhitään levy sillä. Lopuksi levy kuiva-

taan kuumailmapuhaltimella. Tässä on ideana se, että aktivaattoria on vain rei-

kien sisäpinnalla, jotta niihin muodostuu kuparia happoliemessä. Sitten levyn 

annetaan hetki jäähtyä, sillä se ei saa olla yli 50 °C mennessään happoliemeen. 

Seuraavaksi levy lasketaan happoliemeen. Lisätään ”Shine 400” -kiillotusainetta 

ja lientä sekoitetaan. Jos happoaltaan liittimissä on hapettumia, niitä voidaan 

poistaa tarvittaessa esimerkiksi liikuttelemalla liittimiä vähän tongilla. Tämän 

jälkeen levy lasketaan happoliemeen, ja levyn pidiketelineeseen liitetään virta-

kaapeli, jota pitkin levyyn johdetaan sähköä. Sähköä johdetaan myös liemessä 

oleviin kupariharkkoihin. Aluksi virtaa laitetaan noin 6 ampeeria ja tätä arvoa 

nostetaan 8 ampeerin kun kuparia alkaa muodostua. Jännitteen pitäisi olla noin 

0,5 volttia. Levy laitetaan taas liikkumaan edestakaisin. Happoliemessä levy on 

noin 2 tuntia. Levyn oltua hapossa tarvittu aika, levyn liikuttelu pysäytetään ja 

kaapeli irrotetaan. Seuraavaksi levy lasketaan pesualtaaseen ja painetaan 

”spray2”-näppäintä. Levyn annetaan olla altaassa noin 1 minuutti. Pesun jäl-

keen levy kuivataan kuumailmapuhaltimella. Nyt myös reikien sisäpinnalla on 

kuparia. 

2.8 Jyrsintä 

Läpikuparoinnin jälkeen jatketaan jyrsintää. Levy asetetaan jyrsimeen apuviivo-

jen avulla. Sitten avataan BoardMaster ja avataan ”File -> Open” ja valitaan kä-

siteltävä työtiedosto eli .JOB-tiedosto. Alasvetovalikosta vasemmalta ylhäältä 

valitaan ”Read_Bottom”, joka lukee paikkatiedon. Sitten valitaan kuvan 17 mu-

kaisesti ”Configuration -> Clear fid”, joka poistaa vanhan paikkatiedon. 
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KUVA 17. Vanhan paikkatiedon poistaminen 

Tämän jälkeen painetaan ”OK”, ”All+” ja ”Start”. Nyt kamera etsii kohdistusreiät. 

Jos automaattinen paikannus ei onnistu, kamera pysähtyy ja käyttäjä voi manu-

aalisesti siirtää sen oikealle kohdalle painelemalla nuolia ruudulla olevasta ikku-

nasta. Arvo nuolien liikuttelussa on millimetrejä. Kun kohdistusreikä on paikan-

nettu, painetaan ”OK”.  

Seuraavaksi valitaan alasvetovalikosta ”Milling Bottom”. Painetaan ”All+” ja 

”Start”. Jälleen jos makasiinissa ei ole oikeita teriä, ne vaihdetaan, kuten luvus-

sa 2.6 on neuvottu. BoardMaster kysyy, halutaanko jyrsintäsyvyys säätää. Vali-

taan ”Yes”. Sitten valitaan teränsiirtotyökalu (neljä nuolta) ja siirretään terä levyn 

ulkopuolelle lähelle jyrsittävää aluetta. Tämän jälkeen laitetaan terä pyörimään 

terän käynnistysnäppäimestä (pyöreä nuoli). Lopuksi terä laitetaan levyyn kiinni 

teränlaskunäppäimestä (nuoli alas).  
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Määritelty siirto näppäimestä valitaan esimerkiksi 10 mm ja painetaan ylöspäin 

osoittavaa nuolta, jolloin terä jyrsii aihioon 10 mm pitkän viivan. Kun viiva on 

jyrsitty, nostetaan terä ylös samasta näppäimestä, jolla se laskettiin alas. Sitten 

terä pysäytetään samalla näppäimellä, jolla se käynnistettiin. Tämän jälkeen 

painetaan ”P”-näppäintä, jotta jyrsimen luukku voidaan avata. Kuvassa 18 on 

merkitty punaisella käytettävät näppäimet.

KUVA 18. Tarvittavat näppäimet 

 Avataan luukku ja tarkistetaan jyrsityn uran leveys mitta-asteikolla varustetulla 

”luupilla” eli suurennuslasilla. Leveys tarkistetaan aina uran pohjalta. Jos syvyys 

ei ole oikea, terän korkeutta säädetään pyörittämällä säätörengasta. Yksi nak-

sahdus tarkoittaa 4 mikrometriä. Säätörengas sijaitsee tallan yläpuolella mootto-

rin alla. Kun syvyys on oikea, siirrytään itse jyrsintään. Jos halutaan olla varma, 

että jyrsintä tapahtuu oikeaan kohtaan, voidaan jyrsittäväksi valita vain yksi pä-

di. Tämä tapahtuu valitsemalla BoardMasterissa haluttu pädi rajaustyökalulla ja 

painamalla sen jälkeen ”+” ja ”Start. Tarvittavat näppäimet on merkitty kuvaan 

18 mustalla. Kun halutaan aloittaa lopullinen jyrsintä, painetaan vain ”Start”-

näppäintä. Jyrsinnän alussa on hyvä tarkkailla, että jyrsintä tapahtuu oikeaan 

kohtaan ja kaikki vaikuttaa muutenkin normaalilta. Kun jyrsintä on valmis, 

BoardMaster kysyy pysäytetäänkö työ terän säätöä varten. Valitaan ”Yes” ja 

toistetaan terän jyrsintäsyvyydensäätö kuten aikaisemminkin.  
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Tämän jälkeen painetaan ”Start” ja jyrsintä jatkuu. Jyrsinnän jälkeen valitaan ”P” 

ja tarkistetaan silmämääräisesti, että jyrsintä on onnistunut. Sitten käännetään 

levy. Levy täytyy kääntää aina x-akselin ympäri, jotta se tulisi oikein päin jyrsi-

meen. Seuraavana valitaan alasvetovalikosta ”Read_Top” ja toistetaan kaikki 

samat työvaiheet kuin ”Read_Bottom”-vaiheessa. Valitaan vain kaikkiin ”bot-

tom”- kohtiin ”top”. 

2.9 Juotteenestopinnoite 

Jyrsinnän valmistuttua tarkistetaan silmämääräisesti, että se on onnistunut, ja 

hiotaan levyn pinta karhunkielellä. Sen jälkeen laitetaan lämmitysuuni lämpe-

nemään 80 °C:seen. Odotellessa avataan CircuitMaster ja sieltä työtiedosto 

.cam. Painetaan ”View -> Layers” ja poistetaan näkyvistä muut kerrokset paitsi 

maskit. Ensin otetaan vain alapuolen maski näkyviin ja avataan ”File -> Print + 

Preview -> Print”. Sama toistetaan yläpuolelle. Tulostus tapahtuu normaalille 

piirtoheitinkalvolle.  

Seuraavaksi sekoitetaan väriainepussin ja kovetinpussin sisällöt keskenään. 

Tällä seoksella maalataan koko levy käyttäen telaa. Pyritään siihen, että maalia 

ei menisi levyssä oleviin reikiin. Kun levy on maalattu, se laitetaan 80 °C:seen 

uuniin kymmeneksi minuutiksi. Levyn oltua uunissa tarvittava aika, sen anne-

taan jäähtyä hetki. Odotellessa käytetään UV-valotuslaitetta 70 sekuntia päällä, 

jotta saadaan sen lamput lämpenemään. Sen jälkeen levyn päälle laitetaan tu-

lostettu kalvo ja levy asetetaan UV-valotuslaitteeseen 70 sekunniksi. Sama toi-

menpide toistetaan levyn molemmille puolille.  

 

 



                    

Piirilevyn valmistus -työohje  LIITE 1/23 

 

 

 

Valotuksen jälkeen sekoitetaan vettä 1 litra sekä pussi ”Developer”-ainetta laa-

keaan astiaan, johon levy lasketaan apukoukkujen avulla. Levy pestään tässä 

liuoksessa pensselin avulla. Tarkoitus on pestä juotteenestopinnoite pois niiltä 

alueilta, jossa sitä ei pidä olla, esimerkiksi pädien päältä. Pesun jälkeen levy 

huuhdellaan viileällä vedellä. Seuraavaksi lämmitysuuni laitetaan lämpenemään 

160 °C:seen. Uunin lämmettyä levy laitetaan sinne 30 minuutiksi. 

Odotellessa pestään käytetyt pensselit ja astiat. Käytetty liuos pitää neutralisoi-

da ennen sen kaatamista viemäriin. Neutralisointi tapahtuu sekoittamalla liuok-

seen viisi litraa vettä sekä seitsemän grammaa ”Conditioner”-ainetta. Levyn ol-

tua lämmitysuunissa tarvittu aika, niin sen annetaan jäähtyä. Kun levy on jääh-

tynyt, sen pintaan ruiskutetaan ”Cleaner”-ainetta ja harjataan se pensselillä. 

Tällä poistetaan hapettumat levyn pinnasta. Lopuksi levy huuhdellaan vedellä ja 

kuivataan kuumailmapuhaltimella. 

2.10  Levyn irrotus aihiosta 

Viimeisenä työvaiheena on levyn irrotus aihiosta. Avataan BoardMaster ja ase-

tetaan levy jyrsimeen yläpuoli ylöspäin. Avataan BoardMasterilla .JOB-

työtiedosto. Valitaan alasvetovalikosta ”Read_Top” ja toistetaan samat työvai-

heet paikan luvusta kuin aikaisemminkin. Seuraavaksi valitaan alasvetovalikos-

ta ”Cutting outside” ja painetaan ”All+” sekä ”Start”. Näin jyrsin leikkaa levyn 

aihiosta irti jättäen aikaisemmin valitut kulmakohdat leikkaamatta. Tämä työvai-

he näkyy kuvassa 19. Kun leikkaus on valmis, otetaan aihio pois jyrsimestä ja 

pyöräytetään levy siitä irti. Lopuksi hiotaan terävät kulmat viilalla. Näin piirilevy 

on valmis. 
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KUVA 19. Levyn irrotus aihiosta 
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PIIRILEVYN VALMISTUS
Oskari Ranta 2012

Tietotekniikan osasto

Johdanto

Oulun seudun ammattikorkeakoulussa on 
mahdollista valmistaa useamman 
kerroksen piirilevyjä asiakkaiden 
tilauksesta. Piirilevyt valmistetaan 
jyrsimällä. Tässä työssä esitellään 
kaksikerrospiirilevyn valmistus.

Työvaiheet

Kaksikerrospiirilevyn valmistukseen 
sisältyy useita eri työvaiheita. 
Valmistuksessa käytetään apuna 
Windows-ohjelmia CircuitCam ja 
Boardmaster. Muita välineitä ovat LPKF 
ProtoMat S100 -jyrsin, LPKF Contact -
läpikuparointilaite, lämmitysuuni sekä 
LPKF:n UV-valotuslaite.

KAAVIO 1. Työvaiheet

CircuitCam

CircuitCam ohjelmistolla avataan 
asiakkaalta saadut tiedostot. Näiden 
tiedostojen pohjalta luodaan jyrsimelle 
tarkoitettu tiedosto, josta käy ilmi, mitä 
jyrsitään ja eri terät, millä jyrsitään.

KUVA 1. CircuitCam

KUVA 4. Läpikuparointilaite

Läpikuparoinnin jälkeen levy jyrsitään
valmiiksi.

Juotteenestopinnoite

Juotteenestopinnoite levitetään piirilevyn
pintaan telalla. Sen jälkeen levy
lämmitetään uunissa. Lämmityksen
jälkeen juotteenestopinnoite kovetetaan
UV-valotuslaitteessa.

KUVA 5. UV-valotuslaite

Valotuksen jälkeen levy pestään ja
lämmitetään vielä lämmitysuunissa.

Viimeistely

Lopuksi piirilevy irrotetaan aihiosta
jyrsimellä. Sen jälkeen viilataan käsin
terävät reunat pois levystä.

KUVA 6. Valmiita piirilevyjä

BoardMaster

CircuitCamilla luotu tiedosto avataan 
BoardMasterissa. Jyrsintä ohjataan 
BoardMasterin kautta.

KUVA 2. BoardMaster

Jyrsin

Jyrsimenä toimii LPKF ProMat S100. 
Laitteessa on kymmen terän makasiini, 
joka vähentää terien vaihtelemisen 
tarvetta kesken työn. Jyrsin käyttää 
paineilmatallaa, jolla varmistetaan se, 
että levyyn ei koske mikään muu, kuin 
ainoastaan jyrsimen terä.

KUVA 3. Jyrsin

Läpikuparointi

Läpikuparointi suoritetaan sen jälkeen 
kun levyyn on porattu kaikki läpi 
menevät reiät. Läpikuparointiin 
käytetään LPKF Contact -
läpikuparointilaitetta. Kuparointi 
tapahtuu sähkövirran avulla 
happoliemessä. 
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MANUFACTURING OF CIRCUIT BOARDS
Oskari Ranta 2012

Tietotekniikan osasto

Introduction

Oulu University of Applied Sciences 
manufactures multi layer circuit boards.
The circuit boards are manufactured by
milling. In this work the manufacturing
process of a double layer circuit board is 
presented.

Stages

The manufacturing process of a multi 
layer circuit board has multiple stages. 
The Windows programs called
CircuitCam and BoardMaster are used in 
the manufacturing. The other tools are
LPKF ProtoMat S100 milling machine, 
LPKF Contact coppering machine, 
heating oven and UV-exposing machine.

FIGURE 1. Stages

CircuitCam

The work files of the customer are
opened in CircuitCam. Based on those
files a new file which is used in the milling
can be created. That file contains
information about how to mill and what
blades to use.

FIGURE 2. CircuitCam

FIGURE 5. Through hole plating machine

Milling is finished after through hole
plating.

Solder mask

The solder mask is spread on the circuit
board using a roller. After that the circuit
board is heated in an oven. After the
heating the solder mask is hardened in
an UV-exposing machine.

FIGURE 6. UV-exposing machine

After the exposing the circuit board is
cleaned and heated in the oven
again.

Finishing

At the end of the manufacturing process
the circuit board is detached from the
blank. Finally the sharp edges are filed
manually.

FIGURE 7. Circuit boards

BoardMaster

The file created in CircuitCam can be 
opened with BoardMaster. The milling 
machine is controlled by BoardMaster.

FIGURE 3. BoardMaster

Milling

The milling machine is LPKF ProMat 
s100. The machine has a magazine for  
ten blades. This reduces the necessity 
to change blades during the process. 
There is also a compressed air nut 
which assures that nothing else but the 
milling blade touches the circuit board.

FIGURE 4. Milling machine

Through hole plating

Through hole plating is performed after 
all holes have been drilled to the circuit 
board. The through hole plating 
machine is LPKF ContactT which 
creates copper using an electric current 
in acid liquid.

 


